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INTRODUCTION 

Let me first start out by telling you how empowering self-publishing is for authors. Indie publishers 

enjoy full and often superior distribution to retail sales, faster time to market, greater creative 

control, marketing and promotion flexibility, four to five times higher ebook royalties, and the ability 

to price dramatically lower.  

 Anyone who has read my book How to Self-Publish: A Guide for Author-preneurs, heard me 

speak or taken one of my Selah Press Author-Preneur Training classes might wonder why I am 

creating a PDF eBook. I have expressed many times that I am totally sold-out to publishing using 

CreateSpace and Kindle Publishing. The reason is simple. I wanted to provide screenshots of each 

step along the way. CreateSpace and Kindle do not allow screenshots from their websites to be 

published through their platform. I sincerely request that you do not share, copy, forward via email, 

print extra copies or otherwise reproduce extra copies of this eBook.  

 This eBook is designed to help you overcome the obstacles technology may be presenting 

for you as you work your way through the Self-Publishing process. This book is supplemental to my 

book How to Self-Publish: A Guide for Author-preneurs. It does not repeat or replace the information 

provided in the book, it simply adds on a visual guide to improve your ability to navigate self-

publishing using CreateSpace.  

 In this eBook I will explain how to use Word to publish in CreateSpace. Using Word will 

make life so much easier and it is inexpensive these days. You can spend more do book formatting 

in another program—the explanations in this eBook will be related to using Word as well as the 

template you will be instructed to download from CreateSpace.  

 

GETTING STARTED IN CREATESPACE 

Your first step into the realm of self-publishing is setting up an account on CreateSpace.com. It is 

quite simple. Just follow the prompts. Once you have set up your username and password.  Let me 

quickly go over setting up your free account on CreateSpace touching upon some important steps. 

Your email account is used as your ID. You can change it and the password at any point. You will 

be sent to create a new account to put in your email address, password, first name, last name, 

country, type of media you plan on publishing in. Select a combination of media. CreateSpace makes 

the information available for you in case you decide later to publish a book, audio, or video. It isn’t 

the end of the world if you didn’t select this up front because everything is always available to you 

through CreateSpace.  
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 That will bring you to the Member Agreement. With all agreements you should read the fine 

print. That way you have no surprises. Agree to all the terms and then click continue. Next you will 

need to go to the email address you used to create your account. You will find an email from CS 

asking you to verify your email address. Click on the link in the email and this will bring you back to 

CS.  

 You will find a prompt from CreateSpace saying, Action Required! The tax information does not 

match the Internal Revenue Service (IRS) records. To resume publishing with CreateSpace, please update 

your tax information. Submit Tax Information. Well of course it doesn’t match because you haven’t 

put it in yet. Just click on Submit Tax Information.  

 This will bring you the Royalty Payment Profile. Chose the country, Payee name or your 

company name—if you have a separate business for publishing you will use it. If not use your 

personal name. If you have not incorporated simply use your author name and social security 

number. If you incorporate your publishing company at any point in the future, simply update the 

information with your business entity and Federal Business Tax I.D. number.  

 Include your address, city, postal code and province if it applies. Chose Direct Deposit or 

Check. If you chose direct deposit they will deposit monthly, but if you chose check you must meet 

a minimum threshold to receive payment. I always chose Direct Deposit because it is just easier.  

Fill in whether you are a U.S. citizen, type in your name as a signature, add your date of 

birth, tax ID number, the email address of your createspace login and click submit. If you have a 

business use the Tax ID number of your business, if not use your Social Security number.  

 Another tax related step you can take if you live in a state with sales tax is to get an 

exemption on sales tax for the books you order to resale. First you need to download and submit the 

Resale Verification form: https://s3.amazonaws.com/csp-mw-landing/resaleverification.pdf 

And then fill out the CreateSpace Direct Seller Application 

https://www.createspace.com/pub/l/createspacedirect.do?rewrite=true&sitesearch_query=state%2

0tax&sitesearch_type=SITE 

Once you follow those steps you may not have to pay sales tax on books that you purchase to 

resell. Once you have your CreateSpace account set up it is time to start setting up your first title. I always 

keep a dummy title on my member dashboard. This dummy title allows me to test out ideas, copy, play with 

covers, page count, grab templates, and otherwise test out ideas without disturbing my published titles.  

 

https://s3.amazonaws.com/csp-mw-landing/resaleverification.pdf
https://www.createspace.com/pub/l/createspacedirect.do?rewrite=true&sitesearch_query=state%20tax&sitesearch_type=SITE
https://www.createspace.com/pub/l/createspacedirect.do?rewrite=true&sitesearch_query=state%20tax&sitesearch_type=SITE
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TITLE PAGE IN CREATESPACE 

To add a title click on Add New Title. This will open to a page for you to name your title, which can 

be changed up until you hit publish on your finished project. You can publish a paperback, Audio 

CD, DVD or Video Download. To publish a book chose paperback. I always use the guided set up. I 

like the guided set up over the expert set up because it helps me not miss any of the steps. The guided 

is simple set up is easy enough to use that I don’t see the need for the steam-lined expert version.  

 Once you click on get started you can set up your title information. You should always see a 

working pop-up on CreateSpace whenever it doesn’t take you immediately to the next page. If you 

don’t see a working pop-up or a new page doesn’t open you may need to click on the prompt again. 

Once you are on the title information page you can fill in all the details.  

 On the title information page you can add your book title, subtitle, primary author add 

contributors, designate the book as part of a series, add the series title, include an edition number, 

set the language and publication date.  

Adding contributors is a little bit tricky. The contributor choices on CreateSpace map into 

Amazon.com differently than expected. Createspace provided a list that shows where a choice on 

CreateSpace will map to on Amazon. This handy list will help you chose the right contributor on 

CreateSpace for your books.  
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Abridged by—Maps to Editor 
Adapted by—Maps to Adapter 
Afterword by—Maps to Afterword 
Appendix by—Maps to Contributor 
As told by—Maps to Narrator 
Assisted by—Maps to Assistant 
Associate Editor—Maps to Editor 
Authored by—Maps to Author 
Authored with—Maps to Contributor 
Books and Lyrics by—Maps to Author 
Commentaries by—Maps to Commentary 
Compiled by—Maps to Compiler 
Conductor—Maps to Conductor 
Continued by—Maps to Author 
Contributions by—Maps to Contributor 
Consultant Editor—Maps to Editor 
Cover design or artwork by—Maps to Cover 
Design 
Created by—Maps to Creator 
Designed by—Maps to Designer 
Director—Maps to Director 
Dramatized by—Maps to Author 
Drawings by—Maps to Illustrator 
Edited and translated by—Maps to Translator 
Edited by—Maps to Editor 
Editor in Chief—Maps to Editor 
Editorial Board Member—Maps to Editor 
Editorial Coordination by—Maps to Editor 
Epilogue—Maps to Epilogue 
Footnotes by—Maps to Editor 

Foreword by—Maps to Foreword 
Founded by—Maps to Author 
From an idea by—Maps to Creator 
General Editor—Maps to Editor 
Illustrated by—Maps to Illustrator 
Index by—Maps to Contributor 
Interviewee—Maps to Author 
Interviewer—Maps to Author 
Introduction and Notes by—Maps to 
Introduction 
Introduction by—Maps to Introduction 
Literary Editor—Maps to Editor 
Managing Editor—Maps to Editor 
Maps by—Maps to Cartographer 
Memoir by—Maps to Author 
Notes by—Maps to Editor 
Original Author—Maps to Creator 
Other—Maps to Contributor 
Other Adaptation by—Maps to Adapter 
Other Compilation by—Maps to Compiler 
Other Direction by—Maps to Director 
Other Primary Creator—Maps to Author 
Photographs by—Maps to Photographer 
Preface by—Maps to Preface 
Preliminary Work by—Maps to Author 
Prepared for Publication by—Maps to Author 
Producer—Maps to Producer 
Prologue by—Maps to Contributor 
Retold by—Maps to Adapter 
Revised by—Maps to Editor 
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Screenplay by—Maps to Author 
Selected by—Maps to Compiler 
Series edited by—Maps to Series Editor 
Summary by—Maps to Contributor 
Supplement by—Maps to Contributor 

Text by—Maps to Author 
Translated by—Maps to Translator 
Translation with Commentary by—Maps to 
Translator 
Volume Editor—Maps to Editor 

 
 The majority of the rest of the sections on the title page are self-explanatory, but I will go 

over them each briefly. If you book is part of a series click the box asking about series and fill in the 

series title. This will help Amazon organize the material and increase the odds of them automatically 

suggesting it as a follow up book to the first title. A common practice with series is to sell the first 

title at full price while it is the only book in the series available. Later when the other books in the 

series are published the first book often becomes a lost leader that is either free or with a 

significantly reduced price. Series can create loyal readers and an increased following.  

 If your book is a series add the series title and the volume number of the book you are 

currently working on. Next chose what language your book is written in. Your final choice on this 

page is to pick your publication date. CreateSpace will fill it in with your actual publication date if 

you leave it blank.  

 And then if you leave the publication date blank it will automatically set it to the date you 

publish. If you want to post-date a book you can do it here or if you want to pre-sell your book you 

can set a future publication date. All of these things can be changed or updated before you hit 

publish. You can even leave everything but the title and author blank while you work through the 

process. Make sure you click the save & continue button before moving off this page. A working pop-

up should appear before you are redirected to the next page.  

 

ISBN PAGE IN CREATESPACE 

Your next choice is get an ISBN for your book. You can always come back to this later. This is one 

of the last steps I normally take in the self-publishing process. You have four choices for setting 

your ISBN.  

 

Free CreateSpace Assigned ISBN—This choice makes CreateSpace Independent Publishing 

Platform your book’s imprint of record. With a free CreateSpace assigned ISBN you can sell your 

book through Amazon.com, Amazon’s European websites, a CreateSpace eStore, and all Expanded 

Distribution channels as well as libraries. If you chose to leave CreateSpace you will lose your ISBN 

because it can only be used with the CreateSpace Independent Publishing Platform. Your book’s 
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ISBN information will be registered with BooksInPrint.com® with CreateSpace as your publisher.  

 

 

Custom Universal for $99—Choosing a Custom Universal ISBN allows you to move your book 

outside of the CreateSpace system to any publisher. You can set your own imprint as the publisher 

of your book. This means you can publish under your own publishing house. When you have a 

custom ISBN you can sell your book through Amazon.com, Amazon’s European websites, a 

CreateSpace eStore, and Expanded Distribution channels. You are not eligible for distribution 

through the Libraries and Academic Institutions outlet. However, your local library will pick up your 

book if you contact them. You can set up direct purchases with academic institutions. I do this with 

my books that are used in universities and colleges.  

 

 

 

 Your book’s ISBN information will be registered with BooksInPrint.com®. To do this 
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yourself you will be directed to Myindentifiers.com to buy your ISBN from Bowkers via 

CreateSpace. Once you have your account simply input your username and password.  

 

Provide your own ISBN—If you have previously purchased an ISBN through Bowker or another 

ISBN agency you can submit it. Or you can follow the prompts to buy a new ISBN. This is also a 

way to move a book you own the copyright to with a current ISBN to CreateSpace. If you are 

reprinting your book, the title, author name, and binding type must remain the same. A new edition 

requires a new ISBN. The publisher of record remains the publisher so if you want to take it over as 

the publisher do not chose this option.  

 

 Once you set the ISBN it cannot be changed. The ISBN will be locked. This is why I always 

leave this to the very last minute in case I want to scrap the book, make a major change and or want 

to change what kind of ISBN I want for the project. When you are ready to assign your ISBN click 

on Assign this ISBN. 

 If you are not ready you can jump to the Interior by using the menu on the left hand side of 

the screen. If you skip assigning the ISBN a warning box pop up making sure you meant to leave the 

page with unsaved information. Click yes and move onto the interior page.  
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INTERIOR PAGE IN CREATESPACE 

The interior page is where some big decisions about your book will be made. You can chose to print 

the interior in black & white or full color. Need to decide if you want to print on white paper or cream 

paper. The paper color does not impact the manufacturing price of your book. If you want to have 

full color printing then you can only chose white paper. I suggest ordering a sample book with white 

paper and cream paper if you are not certain. The only choice that will impact the price of your project 

is if you chose full color printing.  

 

Page Count Binding Color or B&W Manufacturing Cost 

100 6x9 Black & White $2.15 

100 6x9 Full Color $7.85 

 

 Next chose the trim size of your book. The trim size is the final size of your book after it has 

been printed, bound, and trimmed. Trim sizes are measured in inches and are given as width by 

height. In the above example, the trim size is 6x9 which means that the printed book is six inches 

wide and nine inches tall. 

 

 I recommend using an industry standard trim size. They can be sold on Amazon.com and 

your CreateSpace eStore, and are eligible for all distribution outlets within the Expanded 

Distribution Channel. (More on distribution channels later!) If you chose a custom trim size the 

book will be eligible to be sold through Amazon.com and your CreateSpace eStore, but will be 
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ineligible for the Bookstores and Online Retailers distribution outlet within the Expanded 

Distribution. Unless the size of your book is part of your gimmick it is worthwhile having a standard 

print size.  

 You can click where it says many more sizes available to see all the standard trim sizes. I 

published four books with a 7x10 trim and four books with a 6x9 trim. I determined that two of my 

books needed to be a 7x10 trim size because of the page count of the books. In a 7x10 book you are 

able to drop your page count more than you can in a 6x9. I guesstimated by using the Estimate your 

book’s manufacturing costs calculators and a rough template that the manufacturing cost of the book in 

a 7x10 would be $4.45 based on page count and $5.36 in a 6x9 based on page count difference.  

 Let’s look closer at the estimate your book’s manufacturing cost options. Once you click on it a 

new page will open up. This is one of my favorite pages in CreateSpace. It can help you make 

decisions about your word count, trim size, full color or black & white printing options and so forth.  

The two tabs I want you to pay attention to are the royalties tab and the buying copies tab. You click on 

the other tabs and find some great information at your fingertips at any time. 

 The page count of your formatted book will not be the same as the page count on the Word 

document you most likely wrote your book in. A Word document typically is set to print on a 

8x5x11 piece of paper. When you use a 6x9 template with mirrored formatting and book sized 

margins the page count increases significantly.  

 The best way to get a rough estimate of your page count in order to estimate your 

manufacturing cost is to cut and paste your text from your original Word document into the 6x9 

blank template. This won’t be exact because you will be leaving blank pages as you format so that all 

the first pages of your chapters land on an odd page, but it will be close. We will go into those 

details later in this eBook. In the meantime, mentally add an extra page per chapter or physically 

move each chapter header to an odd page temporarily by going to Insert in your new 6x9 Word 

template, click on Page Break in Pages. I am giving you this temporary page break method because the 

more permanent method shouldn’t be done until you are actually formatting your final draft.  

 You should also mentally account for a title page, front matter page, a table of contents page, 

dedication page and then any other things you may add such as a from the author, forward, 

acknowledgements, end notes, appendix, resources and so forth. This will give you a rough estimate 

on your page count. This will allow you to make decisions about cutting your word count by making 

a series or editing. Use that rough page count to check your potential royalties under the royalties tab 

and manufacturing costs under the buying copies tab.  
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 To use the royalty calculator click on the royalties tab. Fill in your estimated page count, trim 

size, interior type and then set your price. Next click on calculate and CreateSpace will figure out the 

rest for you.  

 

 To estimate the manufacturing cost click on the buying copies tab.  

 

 Use drop down menus to confirm the interior type and trim size. Next fill in your estimated 

page count and the quantity you imagine you would purchase at one time. You can also estimate 

your shipping cost here as well. The shipping cost per book drops when you order more books at 

one time.  

 Self-published authors need to price their books at or below $9.99. This is the reason that it 

is so important for a self-published author to evaluate their page count, royalties and manufacturing 

cost. I’ve found that in CreateSpace a book with a word count of 50,000 words is able sell in all 

distribution methods at the $9.99 price point for the paperback version.  

 A great case to study of why to stay under $9.99 can be found by evaluating my own books. 

One of my books, The Art, Science & Business of Aromatherapy, is 97,000 words and must be priced at 

$14.99. I created an abridged edition, The Art & Science of Aromatherapy, which is 55,000 words and is 

sold for $8.99. I evaluated my income from Amazon sales for the abridged edition and the full 

length version in April 2016. My income for the shorter, less expensive version was 1122% higher 
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than the higher priced full edition.   

 

CREATING INTERIOR IN WORD FOR CREATESPACE 

Once you have finished writing and editing book it will be time to work on formatting. This is a 

slow and tedious process, but doing it right will make a world of difference in the professional 

appearance of your book. If you haven’t already, chose your trim size and then download the blank 

Word template onto your computer. I recently switched to always choosing the blank template rather than 

the formatted template.  I have discovered that the formatted template is full of bugs and issues that can be 

avoided by using the blank template. 

 Cut and paste your book interior into the blank template you have downloaded. Next from 

file in the new Word document chose Save as and save the document as THE NAME OF YOUR 

BOOK 6x9. As you work on formatting make sure you save any major changes as a new document. 

For instance: once you finish the basic formatting and are ready to load the document into 

CreateSpace you can name it THE NAME OF YOUR BOOK for CreateSpace and when you think you 

are at your final name it THE NAME OF YOUR BOOK Final date and as you make fixes change the 

date to that date. This will help you down the road if a step you make messes up the formatting and 

you want to revert to the previous one and it will help you always know exactly which version is the 

final version you loaded into CreateSpace.  

 As I get to the final versions of my books I create a folder called work product and another 

called final. If I have to make a change a few weeks, months or years down the road I change that 

final folder to not finals and create a new folder called current final. Find the system that works for you. 

It is really easy to lose track of where you are in the process.  

 My advice as we move forward in the formatting process is to resist the urge to skip ahead. 

Formatting in this order has saved me countless hours and when I diverge I tend to cost myself 

time.  Next go to the top of the document and insert your title page, front matter, dedication page 

and table of contents. You can find examples of front matter material at Selah-Press.com under 

resources.  

 You can create a table of contents go to Insert on your Word document, click Tables and then 

build a table that is 3 cells wide and as long as you need. It will give you the option of adding 8 cells 

deep. Chose that and then cut and paste the same table below to extend the table of contents as 

needed. In the first cell write 1, go to the cell beside it and write the chapter title and then the cell 

beside that one will be reserved for the page number. The page numbers go in after you have 
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finished the final formatting of your book. Until I finish the final step of formatting I leave the cell 

walls visible to remind myself to put the page numbers in. Once the page numbers are in you will 

change the boarders to no boarder and leave a clean copy of your table of contents.  

Below are examples:  

1 Becoming an Author-preneur 1 

2 A Comparison of Publishing 
Options 

9 

3 Advice from One Writer to 
Another 

23 

4 Budgeting Money 35 

 

1 Becoming an Author-preneur 1 

2 A Comparison of Publishing 
Options 

9 

3 Advice from One Writer to 
Another 

23 

4 Budgeting Money 35 

 

I always add the back matter prompts after the final chapter in my table of contents to remind me to 

include the about the author section, an appendix if necessary, glossary, index and 

acknowledgements. After your table of contents page you can start chapter one of your book unless 

you have a forward or preface that needs to go in before the first chapter. Scan to the final pages of 

your book and add the prompts for the back matter that your book will need.  

 Recently authors have started to put the about the author and acknowledgements at the back 

of the book. Sometimes you see these at the front of a book, but I recommend putting them at the 

back of the book because you want to best optimize the Look Inside feature that is available on 

Amazon for potential customers. An interested customer can read a limited preview of your book 

using Look Inside on Amazon. If the first few pages full of the necessary front matter plus the 

acknowledgments and about the author then you limit consumers preview of your book.  Look Inside 

shows consumers the cover of the book plus 8 pages of the interior and then the back cover of the 

book. If your about the author is part of what will sell your book to potential readers then by all 

means put it up front, but if it isn’t then don’t.  
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Global Changes in Word 

Now that all the prompts are in the book it is time to work on some basic formatting. First let’s do 

the global changes. Select all the material in the book by holding down the control and a button at the 

same time. If you are on a Mac computer use the command and a buttons. Once everything is 

highlighted take a moment to make all the font the same. Don’t use a font that is too common like 

Times New Roman and don’t be too funky either. You should use a font that isn’t one you use every 

day on your computer as a glorified typewriter. You should choose a font that is easy to read but 

slightly different than the default fonts in Word like Times New Roman and Arial. The font size 

should be somewhere in the neighborhood of 10 to 12 depending on your font. A common and 

very readable font used for book publishing is Garamond.  

 The font needs to be supported by CreateSpace, but there isn’t a list of supported fonts. If 

you don’t use a supported font you have to insert the html code in the final version. Why get 

complicated unless html is your second language?  

 Once you chose the font and it is time to move over to the paragraph choices. Click on 

justified. This will make every paragraph justified. Do not use align left, right or center. Once you 

justify the text go over to the line spacing options. The best option for print is 1.15. Click line spacing 

options in the drop down menu you used to change your document to 1.15. From there a new box 

will open up. Look at spacing and find before and after and change those both to zero. This will allow 

you to manually create the spaces in your document.  

 The next global change is in the paragraph section on Word click the arrow box in the very 

right hand bottom side of that section. This will open the paragraph dialog box. When that opens up 

you have two tabs available to you. Chose the tab line and page breaks. When that opens up look at the 

pagination section, now make sure all of the buttons are totally unchecked including: Widow/orphan, 

Keep with next, Keep lines together and Page break before.  

 In most cases Widow/orphan will be checked. Uncheck it and any others. This give you 

control of the orphans, widows and line breaks. In a future step I will show you how to use those 

when necessary. In Word processing, an orphan is the first line of a paragraph that appears as the 

last line of a page. A widow is when the last line of a paragraph appears as the first line of a page.  

 The next step is to remove all the dreaded double spaces after sentences. If you are like me 

and you took typing class in the 1980’s or earlier, then you have the same ingrained habit I have 

when it comes to overusing the space bar after periods. The old school method was to hit the 

spacebar twice after every time you ended a sentence. The new rule is to only leave one space 
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between sentences—two spaces is literally a typing crime these days.  

 To fix double spaces go to replace (found in the top right hand side of your tool bar) or use 

Control (or command) and H. A pop-up window will appear. In the space for find you are literally going 

to type a period and hit the space bar two times. In the space for, replace type in a period and hit the 

space bar one time. This will find all of your dreaded double spaces and wipe them away. Repeat the 

same process for alternate sentence endings such as question marks, exclamation marks, quote 

marks and so forth.  

 Make a note to yourself to do this again whenever you do edits on your document. Double 

spaces are a major habit and hard to break. I find them in mine all the time and I have been trained 

to edit them out for years.  

 Another smart global search to do at this phase of formatting is a review of all the commas, 

apostrophes and quotation marks. For some unknown reason you may occasionally find these in the 

wrong font in your document. I’ve spoken with Word experts and computer experts and there is no 

consistent explanation for this abnormality.  

 

To do this you use the find function in the top right hand side of the tool bar or Control and F. This 

will pop up a box to put whichever punctuation mark you want to search into the find box. All of 

that punctuation mark will show up and go through them one at a time. If you find an incorrect one 

simply back space over it and put a new one in. It should go in correctly.  

 

Page by Page Changes in Word for CreateSpace 

Once you are done with these changes it is time to go page by page. First let’s do some easy changes. 

Look to see if justifying your document caused any of the last sentences of a paragraph to spread 

across the page. Occasionally you may find a four word sentence spread out all the way across the 

page as Word attempts to justify the line. This can happen with short or long sentences. When you 

see this, it is easy to fix. Simply put your cursor at the end of that sentence and hit enter.  This will 
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cause the last sentence to behave and get into line.  

 Next fix all the indents on the document. The hard and fast rule of indentation on books is 

that the first sentence of the first paragraph on the first page of a chapter should not be indented. 

From there the rules vary about indentation. The key is to pick a style and then be consistent about 

it. You can choose to never use an indent on the first sentence at the top of a page on every page or 

not. But it is too early to remove indentations in your document now–wait until you are totally done 

formatting and then go through and look at the first line of each page. In nonfiction this looks nice 

and clean. But in fiction it can get messy because of all the indentations for dialogue. You can 

choose to stick with the standard indentation in Word or you can change it to be fewer spaces.  

 With line and paragraph spacing stay consistent as well. This is an especially tedious layout 

step in a nonfiction book. Often you have a paragraph or section header or recipe header. You have 

to decide if you want a double space between that header or not. Both are right. Just chose one. If 

you are a blogger you may be in the habit of adding spaces between paragraphs rather than indenting 

each paragraph. For printed books, you should not indent the first paragraph on a page or the first 

sentence after a heading. You should indent all of the other paragraphs. Go through the document 

changing these things.  

 Chapter headings are a big factor that should be considered before you add page breaks. All 

chapter headings generally take up the first one-third or one-half of the page and the new chapter 

starts on the lower half of the page. You can create a chapter header in Word by using a larger font 

size and physically spacing down a few space. In recent books I have changed this practice because I 

like to have my chapter Headers in the same font as my book cover. I now create pictures to use as 

my headers using the font, any images and spacing that I want. I think it looks super clean. But that 

isn’t necessary either. Find what works for you. Either way as you do the next step be sure you space 

down each new chapter one-third or one-half of the page.  

 Now you are ready to look at orphans and line breaks in your document. The widows we 

care the most about are when the last line of a paragraph appears as the first line on a page. The 

other one that can look funky in a book is keep with next and keep lines together. If Word controls it 

then you may have giant gaps at the bottom of a page because Word is keeping an entire paragraph 

together. And sometimes it will over do things by considering half a sentence an orphan. I try not to 

have less than 3 words orphaned or widowed, but I always make a decision based on how it visually 

looks as I come across them. When you see a widow or orphan that looks funny you can manually 

fix it by highlighting it. An then the paragraph section on Word click the arrow box in the very right 
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hand bottom side of that section. This will open the paragraph dialog box. When that opens up chose 

the line and page breaks tab, when that opens up look at the pagination section, now check widow/orphan. 

That should fix it. If things look funky still open it up again and chose keep with next.  

 The next big step is putting in Page Breaks. Start at the very top of your document. We are 

going to put in our page breaks. In order to get our page number and headers to work down the 

road we need to create a page break between every section of the book. In order to do this we must 

work from the “page layout” tab of Word rather than the “Insert section.” You will see the option 

both places but if you use the one under “insert” you will have problems when we get to the page 

numbers and headers. You are not going to want the page numbers to be the actual page numbers. 

Page one is going to start several pages into your document a Chapter One of your book. In order 

to make that work we must set up our document correctly for page numbering to start later in the 

document.  

 To start page numbering later in your document, you must first divide the document into 

sections and unlink them. Later I will show you how to display the page numbering and alter the 

starting value, remove page numbers on blank pages and so forth. To divide the document into 

sections start on the very first page of your document. This will be your title page. Click on the 

document after the prompt for publisher logo.  

 

1. Click Page Layout > Breaks > Next Page. 

 

 Repeat this action at the bottom of each page that should be its own section. That means 

after the front matter copyright page you will repeat by clicking Page Layout > Breaks > Next 

Page. After the prompt for the dedication click Page Layout > Breaks > Next Page. After the 
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table of contents.  Now that you have hit the chapters it is time to start each chapter out 1/3 or ½ 

down the page. Then go to the end of the chapter and go to Page Layout > Breaks > Next Page. 

Repeat this process all the way through all the chapters and even through to the back matter. You 

may chose not to add the spaces at the top of each of those sections, but you still need to hit Page 

Layout > Breaks > Next Page. 

 Now assuming that all of your content is written for the book you should then go through 

the document making sure the first page of every section starts on an odd page number. You will 

notice the title page will be page one of your document. The only time that the next page should or 

could start on an odd page is the copyright front matter page. That is okay if it falls on an even page.  

Sometimes the front matter is so big that you need to use a smaller font to get it all to fit on one 

page. And still sometimes it has to be two pages long. In that case I normally start page one of the 

front matter on the next odd page and allow the second page of it fall on an even page. As you work 

your way through the document never assume that you are seeing all the pages once you have added 

next page breaks to your document. Click on each page and then look in the bottom left hand side of 

your screen to see what page it shows of your document. That is the only true way to know what 

page you are on. Especially as we get deeper into the process.  

 Once next page has been added you do not always see the blank pages that have been added. 

Your next step is to go through each starting page of each section and make sure it is an odd page 

number. This is especially true in nonfiction books. With fiction books it is a matter of preference to 

start each new chapter on odd page after chapter one. If you section is not on an odd page you are 

going to add a blank page by going to Page Layout > Breaks > Next Page. 

 Again make sure the new page is on an odd page and then continue through the document.  

This will make all the chapters start on the right hand page of the book. It looks nice and neat and 

professional. Once you have finished doing that we are going to go back through the entire 

document unlinking the sections. This will make the headers and page numbers work correctly. To 

do so double-click in the header or footer area where you want to display page numbers. This will 

open the Design tab under Header & Footer Tools. Click Link to Previous to turn it off and 

unlink the header or footer from the previous section. 

 The headers and footers are separately linked. I normally go through the entire header 

section and hit save. And then go through the entire footer section and hit save. Once everything 

is unlinked you can work in the headers and footers. Whenever anything doesn’t work double 

check those links—the problem normally can be solved by unlinking the sections.  
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 Occasionally your automatic setting of Word may hid the header and footer section. Word 

has a mysterious disappearing footer and header setting. It is quite simple to fix. Word usually 

displays the white space between the first (or last ) line of text and the edge of the paper. By default, 

Word displays the white space, but you can easily hide it without realizing what you've done.  

To fix it in the document you are working on simply hover the mouse over the top or bottom edge 

of any page until Word displays the white space arrows.  Once you see it, double-click the edge and 

Word will unhide the header (and footer) and the white space.  

 

If you want to permanently remove the white space on your document do the following: 

1. Click the File tab and choose Options in the left pane. In Word 2003, choose Options from 

the Tools menu. 

2. Select Display in the left pane. In Word 2003, click the Display tab. 

3. Uncheck the Show White Space Between Pages in Page Layout View option. 

4. Click OK. 

 

Now that you can see the header and footer space (if you couldn’t already) let’s get into 

page numbers and headers for real. We do not want any page numbers or headers in any of the 

front matter. You do not start counting pages until you get to chapter one. If you have a forward or 

a prologue you still don’t start those on page one. In those cases your page numbers often starts 

using small Roman numerals rather than page one.  To get started click in the header, 99% of the 

time a line will show up and insert itself into your header. To remove that place the curser into the 

header and then click on the home tab >Paragraph area >drop down border menu >“no border” 

Repeat the same process in the footer. Now we can really get to page numbers! Make sure they 

are cleared out and empty in all the front matter.  

 When you get to the first page you want to add page number click in the footer. To do so 

double-click in footer area where you want to display page numbers. Click Page Number and then 
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pick Current Position, and chose Plain. 99% of the time that will put the page number on the left 

hand side of the page. Hit Tab to move it to the center of the page.  

 

 

 

 Next go back to Page Number > Format Page Numbers to open the Page Number 

Format dialog box. 

 

 

 

 If this is a forward or prologue you would change the number format from 1, 2, 3,… to i, ii, 

iii… 
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 Click OK. When you’re done with each section, click Close Header and Footer or double-

click anywhere outside the header or footer area.  

 

 

  

 Then hit save. Get out of the header section and hit save over and over again as you go. This 

work is too tedious to let anything happen to your document or make you lose your work along the 

way.  

 Occasionally you will need to leave blank pages between chapters in order to start your new 

chapter. Those blank pages should be totally naked. Don’t leave a header or a footer on them. Once 

you hit your first blank page you will need to make sure you have a true section break (Layout tab, 

Breaks, Next page) and not the page break that can be found at Insert. Make sure Link to Previous 

is turned it off in both the header and the footer and then delete the header and footer.  
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 Since all the links to the previous pages are broken between chapters you will need to start 

each new chapter off by repeating the process to insert page numbers. Tell it exactly which page to 

start on again. To determine what page you are on you should check the even page before it. This 

may be the end of the previous chapter or a blank page. If it is the end of the previous chapter 

simply use the next page number. If it follows a blank page count the blank page mentally. For 

instance: If chapter 1 ends on an odd page you will need to add a blank even page. If the odd page 

was page 11, the even page is counted as page 12 and then the following chapter starts on page 13. 

Tell Word to start the new chapter on page 13. 

 The last step is going to be adding headers. You should already have all the link to previous 

page links turned off. The simplest option for headers is to name the header of each chapter the 

name of the chapter. This is my favorite option right now not only because it is easier, but it gives a 

directional guide to the reader on every page that they are on. Obviously they are going to know 

what the book title of the book is and most likely the author as well. And if they forget it only takes 

a simple flip to the front of the book that will remind them. But often you may forget what chapter 

you are on. And in nonfiction this can be really helpful to remember.  

 My suggestion is to use the chapter titles in the header. To do so simply go the header and 

type in the title of the chapter. Mostly likely the curser will go to the left hand side of the page. 

Resolve that by hitting the tab button. You may need to type in the header on all pages or some 

pages.  Just make sure it doesn’t go onto the blank pages. At this point you might be ready to cry, or 

at least take a break.  Always, and I mean always, hit save before you take a break.  

 These are the really big parts of formatting. If you do any editing after you set headers and 

footers you may have to go back into the document and fix a few.  

 Now let’s pretend that you are totally done with editing and formatting and you are ready to 

load your interior. You would hit “save as” on your document and change your document from a 

Word document to a PDF.  
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 Loading a PDF rather than a Word document cuts down on errors when CreateSpace 

uploads, processes and converts to a PDF. If you want to load in Word that is okay, but if you are 

having problems show up when you view the Digital file that you cannot see in your Word 

document then it is being caused when CreateSpace converts your file to a PDF. So if you load it in 

a PDF you eliminate that problem.  

 

 If you load in a Word document then CreateSpace will convert the file to a PDF. 

CreateSpace will do an automatic print check. They will point out resolution issues and spelling 

problems. This does not mean they are checking to see if you did a nice job with the layout or not. 

That is totally up to you.  
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 In the final review by CreateSpace they do check your page numbering and point out any 

errors.  

 Createspace wants all images to be saved in at least 200 dpi. They will let you continue 

processing even if you load something that isn’t high resolution, but they warn you in advance that it 

may not look clear when printed.  

 I always double check that my images are high resolution, and sometimes I get the warning 

anyway. I’ve also published a book that had images that we knew were not high resolution because 

they were old photographs. They still ended up printing just fine. Do your best to have high 

resolution images though whenever possible.  

 

 

 Once CreateSpace finishes their print check, a message pops up telling you if they did or did 

not find any issues. If you need to fix something, do it and then repeat this step. You will see on left 

bottom hand side of the page Upload a different file and that is what you will click on if you need to fix 

something.  
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 Your next step is the click the blue button that says Launch Interior Reviewer. This will open up 

digital interior reviewer.  

 

 Click “Get Started”  

 From here you are going to go page by page looking at the details. You are looking at page 

numbers, headers, indentations and all the visual details of your book. You may also catch other 

errors as well. Go through the entire document and as you find errors fix them on the most recent 

Word version of your book. 

 

 

 I always hit save as and change the date or edition number of the new revision. Once you go 

through the entire document page by page and make the fixes in the document then you are ready to 
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choose save and continue (if there are no changes) or Go back and Make Changes (if there are changes). 

Repeat as many times as you need to until the PDF version you load is perfect. And then hit “Save 

and Continue.” 

 Do not get discouraged if you have to repeat this process many, many, many times. I’ve been 

through this step dozens of times and always have to make changes several times until the little bugs 

are worked out. After you choose save and continue you will be brought back to the interior page. This 

time click on Continue instead of upload a different file or launch interior reviewer. 

 

COVER PAGE IN CREATESPACE 

You will be brought the Cover page. Choose matte or glossy. It is WAY too early to be designing a 

book cover but you can use this extra time to order a sample of a Matte and/or Glossy cover. I have 

been slowly converting all my covers to matte. It just looks awesome in matte. But above that 

consumers seem to like matte better.  

 Before publishing Puffy & Blue I ordered a proof in both matte and glossy. Both on social 

media and in person the matte cover won hands down. It wasn’t even a contest in person. Matte was 

a clear winner.  

 

What people don’t like about GLOSSY 

 It shows fingerprints and fingerprints  

 It looks less modern. 

 It causes a glare that makes it harder to read the copy on it.  

 If it gets bent, the glossy sometimes peels off. 

 

On the plus side GLOSSY 

 The colors are more vivid in glossy  

 Shiny things draw attention on a shelf…but according to many experts the glare outweighs it 

because you can’t stand anywhere in a store and read it.  

 

The negatives of MATTE 

 The colors aren’t as bright. 
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The positive about MATTE 

 People like the feel of a matte book in their hands 

 The matte looks more professional. 

 It seems more durable. 

 It doesn’t show as many fingerprints. 

 Lots of books are matte these days, which makes a debut author look with the times.  

 

Professional Cover  

You can see the prices in here of the cost for having CreateSpace make your cover for you. Theirs 

start at $399 – you can find ones for more and for less. For instance Selah-Press cover design starts 

at $300. You can pay more or less.  

 

 

  

Under #2 you can choose to build your own cover online or have CS build you a Professional cover design or 

upload your own print-ready PDF cover. We are going to go over build your cover online and upload a print-

ready PDF cover. My two cents on using Cover Creator is that it just isn’t good enough in most cases 

makes the cover scream, “I am self-published and I took the cheap route.”  

 But I want you to know how to do it. There may be a case where the image you have works 

perfectly using Cover Creator. And I also sometimes use it to toss a simple cover onto the proof 

while we work out the final cover. To build your own click on the circle.  
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Click launch cover creator. 

 

 

  

 This will open to a page to choose from themes, fill in the title, subtitle, authors, front cover 

images, author photo, back cover text, publisher logo, background color, box color and font color. 

There are many theme options – they change the font and layout of each design.  

 

 

 Once you find on you like click “next”.   

 In the following steps CS may transfer the information-still take the time to look it over. 
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Fill in the title and hit next. The subtitle and next. The author name and next. And then you can fill 

in the front cover images. You can use one of theirs, but I don’t recommend it because you could 

end up looking like someone else’s book. Or choose to upload your own image. This particular 

layout I clicked on repeats the same image. There are a variety of themes that do different things.  

 

 

 

Follow the instructions provided on the page regarding the size, shape and quality of the image. 

Once you are happy with the image then hit next. Upload your author photo and next. Cut and 

paste your back cover text. Now this is one of the many reasons I am not a fan of using cover 

creator to make your cover. The text is justified, but it will automatically cut words in half to justify 

and it just looks tacky.  
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 Once you have your text in hit apply. Load your publisher logo and next. It will need to be 

the right shape and size. 1.25x0.8 with an image resolution of 300 dpi. And now you can choose 

your color background.  

 

 

  

Once you find one you like, hit next. If you theme has boxes in it then you can choose your box 

colors. Once you are happy hit next.  

 Choose your font color and next. If you like your design, hit “submit cover.” But if you 

don’t like it you can choose to “change design” or go into each tab one by one and make changes.  
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Professional Design 

If you have the skills to do your own cover design using software such as Adobe or Corel Paintshop 

or Serif or whatever then you simply need to get the dimension of your book. Or if you are going to 

hire this step out your graphic designer can use the information from this step. Click on submission 

requirements to be sent to this page. https://www.createspace.com/Products/Book/CoverPDF.jsp 

 

 

 

 See the link download cover templates. Click on that to have CreateSpace make a template that 

accounts for your trim size and exact page numbers.  

https://www.createspace.com/Products/Book/CoverPDF.jsp
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 Fill in the trim, page count, color of paper and print color and then click build template. It 

will then take you to a template to download.  

 

 

 

 Once you have your template than your designer or you can build the cover and come back 

to load your cover on the main cover page. Once you have it loaded click save. Once your cover is 

ready you can hit continue.  If at any point you need to skip a step while the interior or cover are 
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being worked on that is okay. You can use the navigation buttons on the left hand side of the page 

to navigate.  

 But to complete set up you will need to have your interior and your cover loaded.  

 

 

  

Once it is all loaded you can click the blue button on the bottom right that says submit files for review. 

This will trigger a process that can take up to 24 hours to complete. CreateSpace does a closer 

review of your files. But they still won’t tell you if you if it doesn’t look pretty. They will tell you if 

you messed up your page number though and repeat any other messages they have been telling you 

about resolution.  

 While you wait for the email you can continue working on details. But when you get the 

email you it will be time to order a printed proof. You are getting close to having an actual proof 

copy of your book in your hands!  

 

“Being the first to cross the finish line makes you a winner in only one phase of life. It's 

what you do after you cross the line that really counts.” ~Ralph Boston 
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 To order a proof you will pay your manufacturing cost of the book plus shipping. I normally 

am so excited that I pay for the overnight or faster delivery choices. Every time you order your 

books from CreateSpace they will quote the price and estimated delivery date so you can choose the 

delivery method that fits your time frame.  

 

 

  

 My preference is to have my editor do a final edit on the printed proof first and give it back 
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to me. From there I go over the book in great detail looking at the formatting and fixing any repairs 

from the editor. My preference is to go through this process 2x. Both times I carefully review the 

digital proof and then order another printed proof. You can never be too safe or careful, especially 

when you are new to the book publishing process. You don’t want to order 100 or even 10 and 

discover you caused a new problem when you did the edits. The one time I rushed the process and 

ordered 10 copies—I missed an error. I did a drawing for people to win the blooper copies.  

 While you waiting the 24 hour process for Createspace to do their review you can finish 

filling out all the other details for your book.  

 

DISTRIBUTION CHOICES IN CREATESPACE 

 

Under the Distribute Tab go to channels.  

 

 

 

You want to choose everything available to you.  

 

Under the standard channels you will see: 

Amazon.com 

Amazon Europe 

CreateSpace eStore 
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Under Expanded Distribution you will see:  

Bookstores and Other Retailers 

CreateSpace Direct 

Libraries & Academic Institutions  

 

 I mentioned all these options when I talked about ISBN numbers earlier in the course. 

Libraries & Academic Institutions are only available to people who choose a CreateSpace-assigned 

ISBN number. Your highest profit margin is going to be in the Standard Distribution. But don’t 

discount the importance of Expanded Distribution. Amazon is the largest retailer, but there are 

people who prefer to shop at Barnes & Noble or other online bookstore. If your book isn’t there 

they will never find you. When you enable Bookstores and Online Retailers, you can make your 

book available to thousands of major online and offline bookstores and retailers, and expand the 

size of the potential audience for your books. 

 When you enable CreateSpace Direct, you can make your books available to certified 

resellers such as independent bookstores and book resellers. The CreateSpace Direct program allows 

eligible resellers to buy books at wholesale prices directly from CreateSpace. 

You might get to this page and find that one or more of the Expanded Distribution choices that 

should be available showing up as “not eligible.” This is because you haven’t finished all the steps.  

You simply need to go to the “Description” page which can be found under “Distribute” and finish 

the process. What is holding you up is that you haven’t entered your BISAC Category.  

 BISAC Category stands for Book Industry Standards and Communications (BISAC) 

category – which are used by the book-selling industry to help identify and group books by their 

subject matter. Choose the BISAC category that best fits your book. Click on Enter a BISAC code 

and you will see a blue button that says choose beside the box.  

 This is a very important step. THE BISAC is used throughout the book supply chain. It will 

help a brick and mortar store determine where to shelve your book or online stores know whether 

your book is the right fit for their market. 
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 Click on it and a new box will appear. Scan through in search of the best category for you. 

There are several layers to most choices. For instance if you write a fiction book another subcategory 

would pop up, and when you choose one of those another may pop up. Make choices as specific as 

possible.  A good example is my customer Venessa. Her book is fiction, Christian, historical.  

 If you wrote a soap book you would choose Crafts & Hobbies, a new window would pop up 

and you could choose Candle and Soapmaking and that would be the end of the choices.  But if you 

wrote a needlework book about knitting it would be Crafts & Hobbies, Needlework, Knitting.  

Just follow the prompts as far as they take you.  

 

 

 

 On the description page you also should add the book description. The description tells 

potential customers about your title. The description displays in your eStore and on your book's 

Amazon.com detail page, and may be used as your book’s description in other sales channels you 

choose. Your description can have up to about 760 words. 
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What to include in your book description:  

 Describe the story and characters without giving away details that are crucial to the suspense, 

mystery, or surprise ending of the story. A good example of an appropriate book summary is 

the kind you often find on the inside flaps or back cover of a physical book dust jacket. If 

you do provide information from the book cover, be sure you have all necessary rights to the 

book description you provide. 

 Focus on the book itself, but you may also include references to other comparable books 

and/or authors. 

 

This book description should be part of the editing process. Don’t write it at the last minute. In fact 

add it to the prompts on the homework I gave you. Your editor should ensure that it matches the 

book itself. This is also the page that you should add your author biography. This should tell your potential 

customer about you. You can include information your relevant background and qualifications, previous 

works, or personal interests. The author biography displays in your eStore and on your book's Amazon.com 

detail page. The author biography can have up about 475 words. 

 The other key element on the Description page is your search keywords. Search keywords 

can help your title show up on both Amazon.com and search engines. Pick phrases that you think 

customers are likely to use when either searching for your title specifically, or when shopping for 

products that may be similar in subject matter. 

 If you have taken my How to Start Writing a Book class you already heard my spiel about using 

Google to search and rank these keywords. Basically what you are going to do is use Google 

Adword Keyword Planner to search all the keywords related to your book. Evaluate them to see 

what people are searching for. You will see if tens, hundreds, thousands and even millions of people 

are using those keywords to search Google for answers. Double check those keywords on Amazon 

by searching Amazon using the words you have narrowed down to. In Createspace you get 5 

keyword or key phrases that you can enter in and separate with commas. On Kindle you get more so 

save them all for future use.  

 There are a few other self-explanatory choices you can make on this page such as book 

language, country of publication, adult content and large print. Make your choices and hit save and 

continue. Go back to channels and you will find that all but the “libraries and academic institutions” 

will be available to choose. Add all the sales channels that you can and click save and continue.  
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 The next page to fill in is pricing. This is a great tool. You can plug in your price point and 

calculate what your royalty will be in different channels.  

 

 

 

 The majority of sales come through Amazon, but there are opportunities in all of the 

channels. If you only have one book send consumers to your CreateSpace eStore because the profit 

is so much higher. If you don’t like the profit margins of the first number you put in try another, but 

never go higher than $9.99 if possible.  

 

 

 

 To get the Amazon Europe prices to change click on the “Yes, suggest a GBA Price (or 

EUR price) based on the U.S. price. I always click on those because I don’t know foreign economies 

or money systems. Once you are happy with your profit margin click Save if all the areas in 
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Distribute already have green check marks. If not click save and continue. Once you have a green 

check mark everywhere you can simply hit save and close out.  

 But it always good to circle back to the Title page under Setup and make sure you have 

included all the contributors to the book that you want to include. You can keep it as basic as only 

adding your name as author or you can add everyone who worked on the book. I like to include all 

my contributors. It often causes Amazon to suggest my books when their books are ordered on 

Amazon and their books show up when my books are ordered on Amazon. I think it is win/win for 

everyone. It is also extremely helpful for building a resume and online footprint for everyone 

involved.  

 After Amazon has finished their review and you have looked at digital and printed proofs 

you can take the final publication steps.  

 

 

 

 At different times in the process you will see in the project homepage where action needs to 

take place. When action required is showing in “interior” it normally is because you need to either 

do a digital review, order a proof or choose “skip interior review” (because you have reviewed and 

reviewed and the copy loaded is the version you are ready to publish.  

 This will cause a pop-up window to make sure that you really want to skip it. Once you say 

yes to that you will come to a new page that shows you if you cover is matte or glossy and the name 

of the final cover version you loaded. Click continue. This will bring you to Complete Setup.  

 I happen to be on the final step of Venessa Knizley’s book so I used her set up page for the 

image.  You will see that everything can still be edited but the ISBN. At any time after you publish 

the book everything is open to edit other than the ISBN number. If you find an error, want to 

update information, want change the cover, or whatever you can still do it.  
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 I like to make my changes late at night so that the book will only be down overnight and by 

morning the updated version will be available. If your book's status is “Available” and you upload new files, 

it will become unavailable for purchase. Your book will remain unavailable until you have approved a new proof with 

your revised files. Any orders placed for your book prior to it becoming unavailable for purchase will be fulfilled using 

the previously approved files. 

 When you order proofs you will reach this page as well. This is what prompts CS to do their 

internal review. Within 24 hours you will receive and email prompting you to order a proof. If you 

have made all your changes and are ready to make this the version you publish then do not order a 

proof. Your book’s status will say “Awaiting Proof Order.” At that time, you can view a digital 

proof, order a printed proof copy of your book, or if you’ve previously reviewed a proof, you will 

have the option to make your book available right away. Simply choose “Approve Proof” and your 

book will become available immediately through the CreateSpace eStore and for your own author 

orders.  

 Your book will be available on all the Amazon.com avenues within 5-7 business days, 

although I normally find it on Amazon.com within a few hours. Expanded Distribution is said to be 

6-8 weeks, but again I see it there earlier. One thing I have noticed about Createspace is that they 

often under promise and over deliver. I never get my books late, always get them on time, but often 

early.  
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 Once you confirm your approval the next screen will pop up.  

 

 

  

 You will see a pop-up notice telling you that all the steps have been completed and with 

further information.  

 One of the options you may stumble upon as you look at the pock around CreateSpace is that they 

will create the formatted Kindle version. Don’t do that. I am going to teach you how to go in and make sure 

you Kindle looks professional. There are so many little odd ball things that happen to a book when it is 
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converted to MOBI when you load it into the KDP. Those do not get handled in the CreateSpace 

conversion. Look for those details in my eBook Self-Publishing through Kindle. For more details about self-

publishing check out my book How to Self-Publish: A Guide for Author-Preneurs. The chapters include: 

Becoming an Author-preneur, A Comparison of Publishing Options, Advice from One Writer to Another, 

Budgeting Money, Building an Author Platform, Budgeting Time, The Importance of Editing, Formatting, Layout 

& Other Details, Cover Design, Pricing to Sell, Business Tips for Author-preneurs and You’re Published, Now 

What? and so much more.   
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have literally been involved in thousands of businesses. The root of Essential Wholesale’s success 
was its involvement in helping thousands of other small business owners succeed. Through Selah 
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years of writing, speaking and business experience.  
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